Manual for Digitization

with ATIZ Scanner and Software

4th Version DRAFT,
Updated 05/02/2017

Wise Law Library
Contents

Digitization Workflow .............................................................................................................. 3

Part 1: Image Capture ........................................................................................................... 4
  Section 1: Preparing to Scan Bound Volumes .................................................................. 5
  Section 1a: Preparing the rig to scan ............................................................................. 5
  Section 2: Image Capture ................................................................................................. 6
  Section 3: Common BookDrive Capture Errors .............................................................. 12
    Section 3a: Unhandled Exception Error ....................................................................... 13
    Section 3b: Continuing a Partially Captured Book ..................................................... 13

Part 2: File Conversion ....................................................................................................... 15
  Section 1: Digital Photo Professional ............................................................................ 16
    Section 1a: Digital Photo Professional File Conversion .............................................. 16

Part 3: Editing .................................................................................................................... 24
  Section 1: BookDrive Editor Pro .................................................................................... 25
    Section 1a: BookDrive Editor Settings ..................................................................... 25
    Section 1b: Editing Book ............................................................................................. 26
  Section 2: Editing with Photoshop .................................................................................. 30
  Section 3: Editing with GIMP .......................................................................................... 31
  Section 4: PDF creation with ABBYY FineReader .......................................................... 33
  Section 5: Work Report ................................................................................................... 36

Part 4: Collection Specific Processes .................................................................................. 39
  Section 1: Collection Specific Processes ...................................................................... 40
  Section 1a: Colorado Supreme Court Briefs ................................................................ 40
Digitization Workflow
Part 1: Image Capture
Section 1: Preparing to Scan Bound Volumes

The ATIZ scanning rig is a platform for capturing images of pages in bound books. Its main parts are a movable cradle with glass guard, two canon digital cameras angled to capture a left and right page image simultaneously, 4 LED lights, a fan to cool the lights, shades and hood to focus light, and metal frame that holds everything and positions parts in proper relation to one another. The two cameras are linked to the project computer via USB cable and can be controlled either with the BookDrive Capture or with the EOS Utility on the computer’s desktop taskbar.

Section 1a: Preparing the rig to scan

A. Turn on the project computer.

B. While the computer is booting up, flip the switch location on the ATIZ’s rig’s left column. This switch should be facing you and have four plugs beneath it. Flipping the switch will engage the LED lights and fan.

C. Remove the lens cap from the camera on the right and turn on the camera.

D. Turn on the camera. The switch is located on the top right side of the camera, beside the mode dial. The on/off switch has three positions: “OFF”, “ON” and “MOVIE.” Pull the switch toward the front of the camera, making sure to only move the dial one click to the “ON” position and not two clicks to the “MOVIE” position. Make sure you are pulling the on/off switch and not the mode dial. Disturbing the mode dial will change the camera’s settings and will result in uneven image capture.

E. Repeat the same procedure for the left-side camera.

F. Lift the glass guard away from the cradle. Hold the guard with one hand as you place the item with the other.
G. Open the item to the first page and place in the middle of the cradle with the back resting on the cradle’s surface.

H. Slide the two stops into position on either side of the book’s binding so that they hold the item in place on the cradle. It is important that the item not move during the scanning process.

I. Lower the guard on to the item.

**Section 2: Image Capture**

“Image capture” means taking pictures of each page of an artifact. The image capture process is performed with a program called *BookDrive Capture*. This program deposits your photographs into a single folder and puts them in proper page order using a sequential naming convention. Before an item can be scanned there has to be a place for it on the computer. Begin your digitization project by creating a folder to store your output. This folder will start on the desktop and move to the local drive once the project is complete. The desktop has four areas that mirror the workflow of your digitization project: Step 1, Capture; Step 2, Edit; Step 3, PDF Creation; Step 4, Finished Project.
Step 1: Create an item folder

A. If you are starting a new item, create a folder for it by right clicking on the desktop and selecting “new folder” from the menu.

B. Name the folder with the title of the item, example: 1978 Senate Journal. This folder will contain the RAW, tiff and master files for all the item’s pages. Open the folder you just created. Right click and select “new folder” from the menu. Name this folder “tiff.” You will need this folder for the export process which is explained later in this manual. The RAW folder will be created during the capture process and the master folder will be created during the editing process.

C. Move the item folder into the “To Be Scanned” box on the desktop.

Step 2: New Book Settings

A. Double click on the BookDrive Capture 6 icon on the project computers desktop. The program will present you with a window in which you will select the settings for image capture. You will also enter some information about the work you are capturing in the Metadata tab.

B. **New book window:** The “new book” that BookDrive is going to create will actually be a folder that contains the individual images of each page you digitize. Give your book/folder the generic name of “RAW.”

C. Now specify the destination where the scanned pages will be saved. This should be the item folder that you created in Step 1. Click on the folder icon next to the destination text box to use a finder window to locate the folder on your desktop.
D. In the “How to name file” section confirm that the first box is set to “4.” This will create a four-digit file name for each image.

Step 3: Metadata

A. Select the “Metadata” tab.

B. Fill out the fields for title, year published, and the digitizer’s first and last name.

C. Press Start.

Step 4: Camera Settings

Once you have initiated a new book, you will see the BookDrive capture work window.
It is composed of three main sections: the largest displays the left and right page images captured on each shot, the narrow pane running vertically to the left displays the collection of images shot, and the narrow ribbon running horizontally on top of the window contains tools and displays for capture settings. Every time you open the BookDrive Capture work window, you should check your settings. Ensure that the crop tool is disabled. The camera settings should be identical for both cameras, with shutter speed set to \( \frac{1}{50} \), Aperture set to F5.0, and IDO set to 200.

![Camera Settings](image)

**Step 5: Camera Distance**

The cameras need to be positioned so that they are as close as possible to the page. When making adjustments to camera position, always start with the camera on the right. First, you will need to select the camera icon for the left page.

![Camera Preview](image)

This replicates what you would see if you were to look into the camera’s viewfinder. You can only preview one camera at a time.

Move the camera so that the full page is in the frame with some extra border space surrounding it. There is a knob on the side of the tracks that the camera is fixed to, loosen it, and the camera will be able to slide closer or further from the page. Once the distance is correct, tighten the knob.

Once the first camera’s distance is correct, adjust the second camera. There are markings on the slide the camera is attached to that indicate approximately where the cameras should be for different formats. These markings are useful for positioning the cameras so that they are an equal distance from the object. You will know that you have positioned the cameras correctly if:

- The page comprises almost the entire frame with only a thin border space surrounding it
- Page image in either camera are equal in size
Step 6: Focus Camera Lens

The camera has two focus methods, manual and automatic. Automatic focus is preferred. Manual focus should only be used when the automatic focus fails to yield an acceptable focus.

Step 6a: Automatic Focus

A. The autofocus switch is located on the left side of the camera lens. Pull the switch forward to engage the autofocus. Do this for both cameras.

B. The autofocus will not work if one or both of the pages are blank, so to obtain the correct focus, place a test card over any blank pages to give the camera something to focus on, and you something to check. The test card should rest on the page itself, not the shield.

C. Click the camera icon for the right camera. Wait for the autofocus to engage, you will hear the camera making a noise as the lens adjusts. Once the noise has stopped, click the camera button to stop the live view. Now do this for the left camera.

D. Take a test picture: Press “+” on the project computer’s keyboard. This is the control to trigger the cameras to take a picture.

E. You should see the pictures you took displayed in the BookDrive Capture viewer. If the images are upside down, click the settings option on the menu at the top of the window. Under settings click “Invert Camera.” This will flip the cameras on the next picture you take.
F. Examine the photos you took up close to check the focus at the pixel level. Press the “m” key on the keyboard. This should open a magnification window over the left and right page image.

G. Click the blue crosshairs icon and move your cursor to the area of the image you want to zoom.

H. If one or both of the images is slightly out of focus, repeat steps 3 through 6. Once you are satisfied with the focus press the ‘m’ key to close the magnification window.

I. After you have achieved a clear image, you will need to disengage auto focus. Being careful not to touch the focus ring on the front of the lens, push the focus switch toward the camera body.

J. If after several attempts, auto focus does not provide a clear image, manual focus should be used. See the following for instructions on how to manually focus the cameras.

Step 6b: Manual Focus

A. Ensure that the focus switch is set to manual on both camera lenses.

B. Click the camera icon for the left page. Spin the focus ring on the right camera. You should see the difference in the preview. Spin the focus ring until an acceptable focus is achieved.

C. Click the camera icon for the right page. Spin the focus ring on the left camera. You should see the difference in the preview. Spin the focus ring until an acceptable focus is achieved.

D. Once the focus has been adjusted for both cameras, take a test picture. Press enter to snap the photos.
E. Examine the photos you took up close to check the focus at the pixel level, using the magnification window.

F. If one or both of the images is slightly out of focus, repeat steps 2 through 4.

**Step 7: Capture Page Images**

Once you have set the correct camera position and focus and checked that the camera settings are correct, you are now ready to begin capturing images.

A. Press down lightly on the glass guard to open the binding and flatten the page you are trying to capture. Press enter on the keyboard. Listen for the camera shutters to click on both sides.

B. Lift guard, change page, lower guard, press enter.

C. You will also want to monitor the camera focus as you work. For larger items, the page image will lose focus as the page surface gets closer to the camera on the left side and farther from the camera on the right side.

D. Pay close attention to page sequence to ensure you have not missed a page. It’s easy to lose track of your page count and miss a page. If this happens, the sooner you can catch it the better. Since the sequencing of pages in the folder relies on file name, there is no way to go back and insert the pages you missed without updating all of the file names for every single image that was taken after the point where the error was made. If you miss a page, use the replace command described below at the spot where the error occurred and reshoot all subsequent images.
   a. **Replace command:** Right click on the set of images you would like to replace and select “Replace” from the menu. Press the enter key.

E. After you have captured all pages in the item, close BookDrive Capture.

**Section 3: Common BookDrive Capture Errors**

Like many software applications, the BookDrive Capture software contains a few bugs that may impact the software performance. The following tips will assist you in responding to these errors.
Section 3a: Unhandled Exception Error

The “Unhandled Exception Error” may occur in either of two different situations, when attempting to create a new book or during capture of a book. The response to the error varies depending on when the error occurred.

If you encounter the error when attempting to create a new book, select “Continue” and start a new book. If you encounter the error while in the process of capturing a book, select “Quit” and start a new book.

Section 3b: Continuing a Partially Captured Book

The BookDrive Capture software does not allow you to open a previously captured book and continue adding pages. If you encountered the “Unhandled Exception Error” while capturing a book, and had to quit the program, you will need to start a new book.

A. Open BookDrive Capture and enter “RAW2” as the book name.

B. Now specify the destination where the scanned pages will be saved. This should be the item folder that you created in Section 2, Step 1. Click on the folder icon next to the destination text box to use a finder window to locate the folder on your desktop.

C. You will now need to set the page number to continue the sequence from the previous folder. Navigate to the last folder that was captured for the partially captured book and note the last page number (example: 0351).

D. Under the “How to name files” section, change the number from 1 to the next number of the page sequence (example: 0352).

E. Follow steps 3 through 8 of Section 2.
F. If you encounter the “Unhandled Exception Error” multiple times when capturing a book, you will need to complete this process each time. Each time you create a new book the book name should change, counting in order from RAW2 to RAW3 and so on until the book is complete.
Part 2: File Conversion
Section 1: Digital Photo Professional

During the capture process, you were taking RAW images from the camera. These RAW files will need to be converted to uncompressed TIFF files before they can be edited. The application you will use for this is Digital Photo Professional, an image organizing and editing application that is included with Canon EOS cameras. If you had to create multiple RAW folders during the capture process, please proceed to Step 1b.

Section 1a: Digital Photo Professional File Conversion

For our purposes, we will only need to use a few of the functions available in Digital Photo Professional. The following are brief descriptions of the functions we most frequently use.

Selects all of the images in a folder.

Clears the currently selected images.

Applies rotation to page in increments of 90 degrees to the left.

Applies rotation to page in increments of 90 degrees to the right.

Enables you to apply any or all of the following: Rotation, crop and deskew.

This allows for conversion of multiple images into JPEG or TIFF format.
You may access the preceding functions through the tools ribbon of the main window, which is composed of three main sections: across the top of the window is the tools ribbon, the column along the left side is a file directory and the area in the center will display thumbnail images.

Step 1a: Single RAW folder with Text on Right Pages Only

A. Open Digital Photo Professional

B. Using the file directory, navigate to the RAW folder you created during the capture process. This will display the RAW file thumbnails.

C. After all the thumbnails have loaded, the “Select all” icon will become active, press to select all images. Select the “Rotate right” icon to rotate all images. After the images have rotated, you will want to scroll through the thumbnails ensuring that
all the left pages are blank. If you notice a left page with text, select that page, then using the rotate tool, rotate until it is in the correct position.

D. Select the “Trimming Angle” icon from the toolbar. This will open a window where you will set the crop box.

E. If the preview window is showing a blank page, click the “Next” button to move to the first page with text. Left click and hold on the image and draw the crop box. After you are sure the crop box is situated correctly over the page, click the “Copy” button.

F. Select the “Apply All” button, this will apply that crop box to all of the pages you previously selected. Click “Ok” to close out of the preview window.

G. You will need to review the crop boxes to ensure each page is cropped correctly and no text is cut off. Select the “Edit Image Window” icon. This will open a new window. Click on each page with text to review the crop box. If a crop box needs to be adjusted, select the “Trimming Angle” icon, and
adjust the box as needed. IMPORTANT: do not adjust the width or height of the crop box, only move the box around the page as needed. After you have reviewed each page, select the “Main Window” icon.

H. Select the Batch Process icon on the tools ribbon. This will open the Batch settings window. Along the left of the window is the list of RAW files and the remainder of the window displays the various settings.

I. Adjust settings
   a. **Save Folder**: Select the Browse button and navigate to the “tiff” file you created in Section 2, Step 1.
   b. **File Format – Kind of file**: From the drop down menu select “Exif-TIFF 8bit”
   c. **Output setting**: Set Output resolution to 400dpi and uncheck the box for “Embed ICC profile”
   d. **File name**: Select “Current file name”

J. After the settings have been adjusted, select “Execute”
K. The application will begin converting the files, and the following status window will appear. The conversion process will take several minutes.

Step 1b: Single RAW folder with Text on Left and Right Pages

A. Open Digital Photo Professional

B. Using the file directory, navigate to the RAW folder you created during the capture process. This will display the RAW file thumbnails.

C. After all the thumbnails have loaded, the “Select all” icon will become active, press to select all images.

D. Select the “Trimming Angle” icon from the toolbar. This will open a window
where you will set the crop box.

E. If the preview window is showing a blank page, click the “Next” button to move to the first page with text. Left click and hold on the image and draw the crop box. After you are sure the crop box is situated correctly over the page, click the “Copy” button.

F. Select the “Apply All” button, this will apply that crop box to all of the pages you previously selected. Click “Ok” to close out of the preview window.

G. You will need to review the crop boxes to ensure each page is cropped correctly and no text is cut off. Select the “Edit Image Window” icon. This will open a new window. Click on each page with text to review the crop box. If a crop box needs to be adjusted, select the “Trimming Angle” icon, and adjust the box as needed. IMPORTANT: do not adjust the width or height of the crop box, only move the box around the page as needed. After you have reviewed each page, select the “Main Window” icon.
H. Select the Batch Process icon on the tools ribbon. This will open the Batch settings window. Along the left of the window is the list of RAW files and the remainder of the window displays the various settings.

I. Adjust settings
   a. **Save Folder**: Select the Browse button and navigate to the “tiff” file you created in Section 2, Step 1.
   b. **File Format – Kind of file**: From the drop down menu select “Exif-TIFF 8bit”
   c. **Output setting**: Set Output resolution to 400dpi and uncheck the box for “Embed ICC profile”
   d. **File name**: Select “Current file name”

J. After the settings have been adjusted, select “Execute”

K. The application will begin converting the files, and the following status window will appear. The conversion process will take several minutes.
Step 1c: Multiple RAW folders

Before you begin the file conversion on a book with multiple RAW folders, you will need to combine the images from each separate RAW folder into one RAW folder.

A. Navigate to your item folder on the desktop. Create a new subfolder titled “Metadata.”

B. Open the first RAW folder and scroll to the end of the file list, you will see two text files, “AtizCapture” and “ListFiles,” these are the metadata files. Select these two files, right click and select “Cut.”

C. Open the metadata folder you just created, and paste the metadata files.

D. Open the next RAW folder, select the two metadata files, right click and select “Cut.”

E. Paste the files in the metadata folder. Since the metadata files from each RAW folder have the same file name, you will receive a message asking how you would like to proceed. Select “Let me decide for each file.” A new window will open asking which file you would like to keep. Check both check boxes and then select continue.

F. Repeat steps D and E for each additional RAW folder.

G. After the metadata has been moved, you will now need to combine all the images.

H. Open the second RAW folder, and select all images, right click and select “Cut.”

I. Open the first RAW folder and paste the images.

J. Repeat steps H and I until all images have been moved to the first RAW folder.

K. After all files have been moved, delete any empty folders. Follow the steps in Step 1a or Step 1b to convert the RAW files into TIFF files.
Part 3: Editing
Section 1: BookDrive Editor Pro

After you have captured all of the pages for your item, and converted the RAW files into TIFF files, you can begin editing these images to improve readability and portability. The aim of your editing process and the tools you will use will vary greatly depending on the nature of the material. If you are editing page images taken from a book item which contains a regular text block, the best tool to use is BookDrive Editor Pro. This is a proprietary software program that came bundled with our ATIZ scanner. BookDrive Editor Pro is perfect for formatting paginated text material. It will crawl through each page image in a folder and automatically apply changes which you specify via a settings interface. If you are editing images or text material that contains image plates, you will likely need to use a different tool. Section 2 describes editing with Photoshop and Gimp for image material.

Section 1a: BookDrive Editor Settings

For our purposes, we will only need to use a few of the automated editing functions offered by BookDrive Editor. Because of this, you may not have the opportunity to familiarize yourself with the other functions by using them. The follow are descriptions for each function:

**Rotation**
Applies major rotation to page in increments of 90 degrees. Useful if all of your images are upside down or are oriented incorrectly.

**Deskew**
Applies minor rotation to text block in increments of 1/10 of a degree. Can be set to “auto” and text block will be rotated to line up with side of page. This function is not particularly reliable; rotation is not perfect and the edges of the text block can be prepositioned outside of the page frame.

**Level**
Allows adjustment of Red/Green/Blue levels resulting in modulation of shade balance. Useful if you have images in your page and need to represent color accurately. Also useful when converting images to greyscale.

**Contrast**
Allows adjustment of light and dark contrast and brightness level.

**Sharpen**
Eliminates noise and color gradients surrounding text. Good for correction blur if camera was not properly focused.
Eliminates spots resulting from bleed-through or blemishes in the paper. Can correct for spots between 1 and 20 pixels in size. Since our images are captured at a very high resolution, despeckle won’t correct for most spots on account of their being too large.

Converts darkness around page (in this case, the scanner cradle) to white, supposedly so it looks like an extension of the page. Avoid using this feature because it tends to distort text around the edges of the page or close to the gutter of the book.

Removes paper image behind text and preplaces it with a basic negative background. This feature is redundant if you are converting an image to black and white.

Crops image to the same dimensions for every page. It is important that the pages be positioned identically in each image.

Resize image. Excellent way to compress file size.

For typical editing jobs, you will use the rotation, crop and level tools. Other formatting options can be applied by changing “Image type” settings.

Section 1b: Editing Book

Step 1: Open a ‘book’ in BookDrive Editor

A. Open BookDrive Editor

B. Open the item’s scanned page images in BookDrive Editor by clicking the L&R button in the upper left corner of the screen. This will open a finder window. Navigate to the item folder on your desktop and open the “tiff” subfolder that contains the page images you generated during the conversion process. By default,
the explorer window will only display jpeg files. In order to see the tiff files, you will need to change the view to “All files”

C. Press Ctrl+A to select all of the pages, and then click the open button. BookDrive Editor will begin opening each file and arraying them in sequence in the narrow pane on the left side of the application window. Double click on “Book01” in heading and rename “Master”

Step 2: Adjust BookDrive Editor Settings

BookDrive Editor will need about five to ten seconds a page to open every image. For a book length item, this can take as long as 40 minutes. You can set the editing parameters while you wait.

A. Click the wrench button in the upper left of the window.

B. This will open the settings window.
C. **Rotation:** You will only use this feature for items that did not have page rotation applied during the conversion process. Click the rotation icon. This will activate the drop down menus for the L and R pages. Set the L page rotation to 270 and R page rotation to 90.

D. **Level:** You will adjust color level only on items which you will convert to grayscale. In the editing settings panel, click the Level icon on the left column and enable level settings, the icon will change to blue. Click the select box and change the “Automatic” setting to “User Defined.” Then click the magnifying glass icon to set level parameters. A new window will open over the settings window. In the select boxes on the right side of the levels window, change the value in the left box to 40 and the value in the right box to a value such that the page is brightened without losing detail, usually between 180 and 240.

*Explanation:* Changing the level parameters allowed you to specify the spectrum of brightness that can be present within an image. By adjusting the range of brightness, you can make the brightest pixels in your image closer to white and the darkest pixels closer to black, making the image more readable without losing detail.

E. **Destination:** You will need to specify a destination for your edited images just like you did during the image capture. Choose the item folder you created at the beginning of image capture to store the new edited page images.
F. **How to name files**: Adjust the value in the “Digit” box to read 4. You may either edit the number with the keyboard or click the arrow buttons. You will notice the change reflected in the example file names above.

![How to name files](image)

G. **Image type – Format**: Set to TIFF.

H. **Image type – Compression**: set to LZW

I. **Image type – Resolution**: Selectable values are presented in groups of 100. Select the value that most closely matches the calculated resolution of captured images. If you round up or down, this value will likely be 400 or 300. In the event that the resolution of your capture images is 350 or lower, round down to 300.

J. **Image type – Color depth**: Set to Grayscale, unless significant color information is present in the original object; in which case, set to “Color.”

K. Click ok when you have configured all editing settings.

L. You should now once again be viewing the editing screen. Once all the page images for the project have finished loading you may initiate the editing process. Click the play button in the lower left of the window to initiate the editing process. You will see BookDrive Editor begin to edit pages one at a time. While editing, it is also creating new files for the pages and storing them in the item folder.

M. Once the editing process is complete, close the BookDrive Editor window. Navigate to the item folder on the desktop, open the Master folder, and review your edited images.
using the Windows Explorer preview feature. You may now delete all black pages from the collection of page images. If you notice any discrepancies in the page images, you will need to reset the editor settings, and reprocess the images.

Section 2: Editing with Photoshop

If you are only editing a few images or are making spot alterations, you may find image editing software like Photoshop more useful than BookDrive Editor Pro. Photoshop offers a great deal more tools than BookDrive Editor, only a few of which will be described here. A multitude of video tutorials can be found on the internet explaining more advanced uses of Photoshop.

Step 1: Cropping and Image Size

A. **Crop:** Select the crop tool \[ \text{crop tool} \] from the standard tool bar or press “c.” Drag your cursor over the range you would like to keep. The resulting view should show the area you’ve selected for removal shaded and surrounding a dotted border. The crop frame can still be resized by clicking on the corners of the square and dragging with the cursor. Once you have sized the frame to your liking, click enter to apply the crop.

B. **Image size:** Click the “Image” menu item in the top left side of the window and select “Image Size,” or press Alt+Ctrl+I. Resize the image by changing its pixel dimensions. You may scale a picture up or down by percentage or by entering a different pixel value. If you enter a new pixel value for one dimension, the other will automatically adjust so that the image scales proportionally. You may also choose to scale the image by linear measurement, in which case you would change the values under “Document Size.”

Step 2: Color Conversion

Most of Photoshop’s color manipulation tools are found in the Image menu under “Adjustments.”

A. **Brightness and contrast:** Photoshop offers automatic tone, contrast and brightness adjustments. These are probably safer and more reliable to use than making the adjustments manually. The tools can be found in the Images menu. Their shortcut keys are as follows:
Section 3: Editing with GIMP

If you are only editing a few images or are making spot alterations, you may find image editing software like GIMP more useful than BookDrive Editor Pro. GIMP is an open source image manipulation software, similar to Photoshop. GIMP offers a great deal more tools than BookDrive Editor, only a few of which will be described here.

Step 1: Cropping and Image Size

A. **Cropping**: Open GIMP [Image] Open the image you would like to edit, by pressing Ctrl+O or selecting Open from the File menu. The image will open in the image view window.

   Select the crop tool [Image] Drag your cursor over the range you would like to keep. The resulting view should show the area you’ve selected for removal shaded. The crop frame can still be resized by clicking on the corners of the square and dragging with the cursor. Once you have sized the frame to your liking, click enter to apply the crop.

B. **Image Size**: Click the “Image” menu item in the top left side of the window and select “Scale Image.” Resize the image by changing its pixel dimensions. You may scale a picture up or down by percentage or by entering a different pixel value. If you enter a new pixel value for one dimension, the other will automatically adjust so that the image scales proportionally.

   You may also choose to scale the image by linear measurement, in which case you would select a linear measurement from the drop down menu next to the “Image Size” section.

Step 2: Color Conversion

Most of GIMP’s color manipulation tools are found in the Colors menu. We will only discuss the automatic adjustments in this manual, but there are many manual adjustments that are available for use by the experienced user.
A. **Correcting dark background:** To lighten the background of an image you will use one of the automatic color corrections. From the colors menu, hover your cursor over “Auto” and you will notice six different options, only three of which we will discuss here: White Balance, Normalize and Stretch Contrast.

   a. **White Balance:** This will apply an automatic white balance correction to the entire image by stretching the Red, Green and Blue color channels. It will create pure white and pure black. This command can only be used on RGB images, not Grayscale or B&W.

   b. **Normalize:** This scales the brightness values of the image, making the darkest point black and the lightest point as bright as possible, without altering the hue.

   c. **Stretch Contrast:** This stretches the Red, Green and Blue histograms to the fullest contrast range. The dark colors become darker and the bright colors become brighter. This is similar to Normalize, except that it works on each color channel individually and this method may alter the hue.

**Step 3: Saving Files**

Once you have completed all the necessary edits, you will need to save the file. When GIMP opened your image file, it opened it as an XCF file, which is GIMP’s default file format. We will want to save our file in the same format as our original image, which will either be JPEG or TIFF. In order to do this, we will use the “Export” command.

A. From the File menu select “Export As” The “Export Image” window will open. Click on the “+” to the left of “Select File Type”, this will expand a list of file types. Scroll through the list until you find the file type of the original image, either jpeg or tiff, select the correct file type. Ensure that the save location is the files destination folder. Click Export. If exporting file as
JPEG another window will open, select export. If exporting file as TIFF another window
will open, make sure Compression is set to “None”, then press export.

Section 4: PDF creation with ABBYY FineReader

The Wise Law Library uses ABBYY FineReader for superior optical character recognition of text
documents. ABBYY differs from Adobe Acrobat Pro in that it is able to compare text against a
much larger and more comprehensive library of characters than that built into the OCR function
in Acrobat. Also, ABBYY gives the ability to edit the OCR’s plain text document that it produces
before embedding the text into your finished PDF.

A. Open the “Master” folder you created during the editing process. Press
Ctrl+A to select all pages in the folder. Right click and move your
cursor to ABBYY FineReader 12 and select “Open in ABBYY FineReader 12.” ABBYY FineReader will open
and begin running OCR on the PDF it’s creating. The screen will look similar to the image
below.
B. It may take several minutes to an hour for the document to be synthesized. Once complete, ABBYY creates two manifestations of the document: a PDF and a plain text document. The PDF document appears in the image window on the left portion of the interface. You will notice that there are colored boxes overlaying the image. Green boxes represent text, blue boxes represent tables, and red boxes represent images. The plain text document appears in the text window on the right portion of the interface. You may notice that some of the text is highlighted in blue, this is identifying words or letters that ABBYY may have improperly OCR’d.

C. Using the interface’s split pane view, you can compare these two manifestations to make sure that the plain text version that was generated by OCR is correct. Scan the plain text document in the right pane for errors, paying special attention to blue highlighted characters. You can edit the document same as you would in a text editor.

D. Scroll through the thumbnails in the pages window, you may notice that some of the pages are highlighted red, or have this icon in the lower right corner of the thumbnail, these are the pages that ABBYY has identified as possibly containing errors.
E. Click on a page that is highlighted red or has the error icon and confirm that all text is contained within a green text box. If an area of text is not within a green box, you will do one of three things, create a new text box to encompass the text, expand the existing text box to encompass all the text or reclassify a photo box as a text box.

a. To expand an existing text box, select the cursor tool in the toolbar to the left of the image window, left click the cursor over one of the corners of the text box and expand the box to encompass all the text.

b. After you have expanded the text box, left click on the “Read Page” icon in the image window toolbar, this will reprocess just the page where the text box was adjusted, applying the changes you just completed.

c. To create a new text box, select the “Draw Text Area” icon from the image window toolbar. Left click and hold as you draw a text box around the text area. After you have drawn the text box, left click on the “Read Page” icon in the image window toolbar.

d. To reclassify a photo box as a text box, click on the text area that is contained in a red box. This will open the following toolbar. Select the arrow next to the picture icon, and then select text, this will change the picture box to a text box. Left click on the “Read Page” icon in the image window toolbar.
F. After you have completed all the necessary edits, click on the down arrow to the left of the “Save” icon in the ABBYY toolbar. Select “Save as PDF/A Document” from the menu. When the “Save document as” window opens, navigate to the item folder. Use the title of the item as the file name and click save.

Section 5: Work Report

At the end of each of your work shifts, you will document your work progress in the work report. This report is an Excel spreadsheet that serves multiple purposes. Its primary function is to allow student workers to monitor their progress and keep everyone clear on the project process. In addition, it is used to identify any technical problems that may be occurring with the process and to track worker productivity uses it.

A. Open the work report.

B. The work report is split into two sections: Image Capture and Post Production. The Image Capture section is where you will document the items that you captured during your shift. The Post Production section is where you will document the items that you edited during your shift.

C. Enter the date and your full name in the first two columns.

D. In the Image Capture section, there are three columns where you may enter information.
a. **Start**: Enter the title of the item that you started capturing during your shift. This may be a new item or you may be continuing an item that was started by the last worker. If you are continuing an item, note the slide you started from.

b. **End**: Enter the title of the item that you completed capturing. If it is the end of your shift, and you have not finished capturing an item, enter the last slide you captured.

c. **Description of Work**: This is where you will enter information about any problems encountered during the capture process. Make note of program errors or crashes and any other issues that you want to bring to the attention of the next worker or to the supervisor. If no problems were encountered, then this column should be left blank.

E. In the **Post Production** section, there are five columns where you may enter information.

<table>
<thead>
<tr>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Production</td>
<td>File Conversion</td>
<td>Brief Separating</td>
<td>Editing</td>
<td>PDF Creation</td>
</tr>
<tr>
<td></td>
<td>27052-27063 Supreme Court Briefs</td>
<td>27052 Supreme Court Briefs</td>
<td>27218-27224 Supreme Court Briefs</td>
<td>slide 598 is blank and 599 has text</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>27218-27224 Supreme Court Briefs</th>
<th>27218-27224 Supreme Court Briefs</th>
<th>27218-27224 Supreme Court Briefs</th>
</tr>
</thead>
</table>

a. **File Conversion**: This is where you will enter information on any items that you converted from RAW to TIFF files. Enter the title of the item you converted.

b. **Brief Separating**: This is where you will enter information on any items that you completed separating the briefs. Enter the title of the item that you separated.

c. **Editing**: This is where you will enter information on any items you completed editing the TIFF files. Enter the title of the item that you edited.
d. **PDF Creation**: Enter title of any items that were converted into a PDF.

e. **Description of work**: This is where you will enter information about any problems encountered during the post production processes. Make note of program errors or crashes and any other issues that you want to bring to the attention of the next worker or to the supervisor. If no problems were encountered, then this column should be left blank.
Part 4: Collection Specific Processes
Section 1: Collection Specific Processes

While the Digitization workflow is the standard to follow for all collections digitized as part of the Digital Collections Program, some collections may require fewer or additional steps. The following is a guide to collection specific processes.

Section 1a: Colorado Supreme Court Briefs

The Colorado Supreme Court Briefs are contained in bound volumes arranged by docket. Some dockets are spread between multiple bound volumes. When the briefs were captured, we created a single folder of RAW files for each bound volume. These RAW files will be separated by brief during the conversion process. The resulting TIFF files will be separated by docket during the editing process.

Step 1a: Separating and Converting Briefs with Text on Right Pages Only

A. Open Digital Photo Professional

B. Using the file directory, navigate to the RAW folder you created during the capture process. This will display the RAW file thumbnails.

C. After all the thumbnails have loaded, the “Select all” icon will become active, press to select all images. Select the “Rotate right” icon to rotate all images. After the images have rotated, you will want to scroll through the thumbnails ensuring that all the left pages are blank. If you notice a left page with text, select that page, then using the rotate tool, rotate until it is in the correct position.

D. Left click on the first page to select.

E. Scroll through the thumbnails until you identify the last page of the brief. Holding down the “Shift” key, left click on the final page of the brief. This will select all of the pages in that brief.
F. Select the “Trimming Angle” icon from the toolbar. This will open a window where you will set the crop box.

G. If the preview window is showing a blank page, click the “Next” button to move to the first page with text. Left click and hold on the image and draw the crop box. After you are sure the crop box is correctly situated over the page, click the “Copy” button.

H. Select the “Apply All” button, this will apply that crop box to all of the pages you previously selected. Click “Ok” to close out of the preview window.

I. You will need to review the crop boxes to ensure each page is cropped correctly and no text is cut off. Select the “Edit Image Window” icon. This will open a new window. Click on each page with text to review the crop box. If a crop box needs to be adjusted, select the “Trimming Angle” icon, and adjust the box as needed. IMPORTANT: do not adjust the width or height of the crop box, only move the box around the page as needed. After you have reviewed each page, select the “Main Window” icon.
J. Select the Batch Process icon on the tools ribbon. This will open the Batch settings window. Along the left of the window is the list of RAW files and the remainder of the window displays the various settings.

K. Adjust settings
   a. **Save Folder**: Select the Browse button and navigate to the “tiff” file you created in Section 2, Step 1.
   b. **File Format – Kind of file**: From the drop down menu select “Exif-TIFF 8bit”
   c. **Output setting**: Set Output resolution to 300dpi and uncheck the box for “Embed ICC profile”
   d. **File name**: Select “Current file name”

L. After the settings have been adjusted, select “Execute”

M. The application will begin converting the files, and the following status window will appear. The conversion process will take several minutes. You may begin the conversion for the next brief.
N. Left click on the first page of the next brief and scroll until you find the final page. While holding down the “Shift” key left click on the final page of the brief.

O. Follow steps F through I to crop this new set of pages.

P. Select the Batch Process icon.

Q. Adjust settings
   a. **Save Folder:** Select the browse button and select “Make New Folder” name the new folder “tiff2” press “OK” For each new brief, name the folder with consecutive numbers, brief 3 would be tiff3, brief 4 would be tiff4 and so on.
   b. **All other settings:** Same as in previous step

R. After the settings have been adjusted, select “Execute”

S. Repeat steps N through Q until all briefs have been converted to tiff files.
T. After the batch process is complete the status window “Cancel” button will change to an “Exit” button. In the lower right section of the status window confirm that the number next to “Error” is “0.” If no errors occurred during the process, click Exit. You may now proceed to editing the Tiff files you just created.

![Status Window]

**Step 1b: Separating and Converting Briefs with Text on Left and Right Pages**

A. Open Digital Photo Professional

B. Using the file directory, navigate to the RAW folder you created during the capture process. This will display the RAW file thumbnails.

C. Left click on the first page to select.

D. Scroll through the thumbnails until you identify the last page of the brief. Holding down the “Shift” key, left click on the final page of the brief. This will select all of the pages in that brief.

E. Select the “Trimming Angle” icon from the
F. If the preview window is showing a blank page, click the “Next” button to move to the first page with text. Left click and hold on the image and draw the crop box. After you are sure the crop box is correctly situated over the page, click the “Copy” button.

G. Select the “Apply All” button, this will apply that crop box to all of the pages you previously selected. Click “Ok” to close out of the preview window.

H. You will need to review the crop boxes to ensure each page is cropped correctly and no text is cut off. Select the “Edit Image Window” icon. This will open a new window. Click on each page with text to review the crop box. If a crop box needs to be adjusted, select the “Trimming Angle” icon, and adjust the box as needed. IMPORTANT: do not adjust the width or height of the crop box, only move the box around the page as needed. After you have reviewed each page, select the “Main Window” icon.
I. Select the Batch Process icon on the tools ribbon. This will open the Batch settings window. Along the left of the window is the list of RAW files and the remainder of the window displays the various settings.

J. Adjust settings
   a. **Save Folder:** Select the Browse button and navigate to the “tiff” file you created in Section 2, Step 1.
   b. **File Format – Kind of file:** From the drop down menu select “Exif-TIFF 8bit”
   c. **Output setting:** Set Output resolution to 300dpi and uncheck the box for “Embed ICC profile”
   d. **File name:** Select “Current file name”

K. After the settings have been adjusted, select “Execute”

L. The application will begin converting the files, and the following status window will appear. The conversion process will take several minutes. You may begin the conversion for the next brief.
M. Left click on the first page of the next brief and scroll until you find the final page. While holding down the “Shift” key left click on the final page of the brief.

N. Follow steps E through H to crop this new set of pages.

O. Select the Batch Process icon.

P. Adjust settings
   a. **Save Folder**: Select the browse button and select “Make New Folder” name the new folder “tiff2” press “OK” For each new brief, name the folder with consecutive numbers, brief 3 would be tiff3, brief 4 would be tiff4 and so on.
   b. **All other settings**: Same as in previous step

Q. After the settings have been adjusted, select “Execute”

R. Repeat steps M through Q until all briefs have been converted to tiff files.
S. After the batch process is complete the status window “Cancel” button will change to an “Exit” button. In the lower right section of the status window confirm that the number next to “Error” is “0.” If no errors occurred during the process, click Exit. You may now proceed to editing the Tiff files you just created.

Step 2a: Open a ‘book’ in BookDrive Editor

After you have separated the briefs, you will now need to edit the tiff files.

A. Open BookDrive Editor

B. Open the item’s scanned page images in BookDrive Editor by clicking the L&R button in the upper left corner of the screen. This will open a finder window. Navigate to the item folder on your desktop and open the “tiff” subfolder that contains the page images you generated during the conversion process. By default, the explorer window will only display jpeg files. In order to see the tiff files, you will need to change the view to “All files”
C. Press Ctrl+A to select all of the pages, and then click the open button. BookDrive Editor will begin opening each file and arraying them in sequence in the narrow pane on the left side of the application window. Click on the first set of thumbnails so that the title page is visible in the preview window. Double click on “Book01” in heading and rename with the title of the brief.

Step 2b: Adjust BookDrive Editor Settings

BookDrive Editor will need about five to ten seconds a page to open every image. For a book length item, this can take as long as 40 minutes. You can set the editing parameters while you wait.

A. Click the wrench button in the upper left of the window.

B. This will open the settings window.
C. **Rotation:** You will only use this feature for items that did not have page rotation applied during the conversion process. Click the rotation icon. This will activate the drop down menus for the L and R pages. Set the L page rotation to 270 and R page rotation to 90.

D. **Level:** You will adjust color level only on items which you will convert to grayscale. In the editing settings panel, click the Level icon on the left column and enable level settings, the icon will change to blue. Click the select box and change the “Automatic” setting to “User Defined.” Then click the magnifying glass icon to set level parameters. A new window will open over the settings window. In the select boxes on the right side of the levels window, change the value in the left box to 40 and the value in the right box to a value such that the page is brightened without losing detail, usually between 180 and 240.

*Explanation:* Changing the level parameters allowed you to specify the spectrum of brightness that can be present within an image. By adjusting the range of brightness, you can make the brightest pixels in your image closer to white and the darkest pixels closer to black, making the image more readable without losing detail.

E. **Destination:** You will need to specify a destination for your edited images just like you did during the image capture. Click on the folder icon and browse to the item folder you created at the beginning of image capture. Right click on the item to select it and the select “Make New Folder” Name the new folder with the docket number of the first brief. Click “ok”
F. **How to name files:** Adjust the value in the “Digit” box to read 4. You may either edit the number with the keyboard or click the arrow buttons. You will notice the change reflected in the example file names above.

G. **Image type – Format:** Set to TIFF.

H. **Image type – Compression:** Set to LZW

I. **Image type – Resolution:** Selectable values are presented in groups of 100. Select the value that most closely matches the calculated resolution of captured images. If you round up or down, this value will likely be 400 or 300. In the event that the resolution of your captures images is 350 or lower, round down to 300.
J. **Image type – Color depth:** Set to Grayscale, unless significant color information is present in the original object; in which case, set to “Color.”

K. Click ok when you have configured all editing settings.

L. You should now once again be viewing the editing screen. Once all the page images for the project have finished loading you may initiate the editing process. Click the play button in the lower left of the window to initiate the editing process. You will see BookDrive Editor begin to edit pages one at a time. While editing, it is also creating new files for the pages and storing them in the item folder.

M. Once the editing process is complete, close the BookDrive Editor window. Navigate to the item folder on the desktop, open the Master folder, and review your edited images using the Windows Explorer preview feature. You may now delete all black pages from the collection of page images. If you notice any discrepancies in the page images, you will need to reset the editor settings, and reprocess the images.